
[bookmark: _Hlk7167365]Introduction to ‘EndNote Desktop’ X9 (Windows) – 2019 HANDOUT 

If you are using EndNote Desktop on an RMIT computer, you do not need to install it. If you are using your own device, please ensure you install EndNote Desktop from: https://www.rmit.edu.au/library/research/endnote-managing-your-references/endnote-desktop 

This document comprises of:

1. Introduction and learning outcomes
2. Creating and opening a new EndNote Desktop library
3. Exporting references from library databases - EXERCISE ONE 
4. Exporting references from LibrarySearch - EXERCISE TWO
5. Exporting references from Google Scholar - EXERCISE THREE
6. Manual input of references - EXERCISE FOUR
7. Adding or attaching full-text PDFs
8. Groups
9. Selecting referencing styles
10. Using EndNote Desktop with Microsoft Word - EXERCISE FIVE
11. Backing up your EndNote Desktop library
12. Final Tips
13. Conclusion and further help

1. INTRODUCTION AND LEARNING OUTCOMES

This handout:
· Is at beginner's level and covers only the basics of the EndNote Desktop program. It is assumed that you have never used Endnote or are unfamiliar with it.
· Does not cover advanced areas. The following resources address advanced questions:
· EndNote X9 User Documentation (Win and Mac)
http://clarivate.libguides.com/endnote_training/users/enx9
· EndNote.com Training
http://endnote.com/training
· EndNote’s YouTube Channel
https://www.youtube.com/user/EndNoteTraining/videos
· EndNote.com Community (User Forum)
http://community.thomsonreuters.com/t5/EndNote/ct-p/endnote
· [bookmark: _Hlk531792390]EndNote.com Support – Common Questions
https://support.clarivate.com/Endnote/s/?language=en_US

· Does not teach you how to reference. You are expected to have a basic knowledge of referencing and your School’s referencing style. See section 13. 
· Does not teach you how to search in library databases. You are expected to be familiar with basic database searching, as some basic database searching is involved.
· The Library’s subject guide EndNote: a beginner’s guide (http://rmit.libguides.com/endnote) is useful as a self-paced instructional tool.

EndNote Desktop is a software program that:
· Creates, stores and manages your references/citations.
· Saves your selected references/citations from online resources (e.g. library databases, Google Scholar, LibrarySearch) to export them into your EndNote Desktop library.
· Inserts references/citations from your EndNote Desktop library into your Microsoft Word document, and automatically creates a bibliography, so you do not have to manually do so  yourself. Bibliographies are created in your chosen referencing style (e.g. APA 6th, RMIT Harvard, RMIT IEEE, Vancouver, Chicago, etc.).

Learning outcomes:
· Create and open a new EndNote Desktop library.
· Add references to your EndNote Desktop library -- manually & directly from library databases, LibrarySearch and Google Scholar.
· Add or attach full-text PDFs to your references.
· Use EndNote Desktop Microsoft Word in your chosen referencing style.
· Create groups, change referencing styles and create a backup of your EndNote Desktop library.
· Know how to get further help for EndNote Desktop.

2. CREATING AND OPENING A NEW ENDNOTE DESKTOP LIBRARY   

1) [image: ] Start > All Programs > EndNote > EndNote

2) Create a new EndNote Desktop library (File > New) and save it to your preferred location (e.g. desktop or student drive).

3) This will create an .enl file and a .data folder -- both MUST be KEPT TOGETHER in the SAME location for your EndNote Desktop library to work properly. If you move the .enl file to a different location, you MUST move the .data folder with it.
[image: ]

4) To open your EndNote Library, click on the .enl file only. The .data folder is only used by the EndNote program.
3. EXPORTING REFERENCES FROM LIBRARY DATABASES - EXERCISE ONE

Exporting from library databases is best for references typically found in databases, such as journal articles and conference papers. Apart from Google Scholar & LibrarySearch, many of the major databases allow this exporting feature, for example: Science Direct, PubMed, ERIC, Proquest, Informit, EBSCOhost, Scopus, JSTOR, IEEE, Web of Science and Emerald.

To export references from a library database into your EndNote Desktop library:

1) Ensure your EndNote Desktop library is open. Let us use either database below as an example.
2) Choose Science Direct                       OR         EBSCOhost Business Source Complete.

	a) Navigate from Library homepage to Find Resources > Databases > Popular > ScienceDirect
b) Do a search on your topic. 
c) Select the references you want to export by clicking the Box  [image: ] next to each result.
d) Press [image: ] Export.
e) Select  [image: ] Export citation to RIS.
f) If the Save As box appears to save the .ris file, save it to the desktop, then open it. Alternatively, you may have the option to open the .ris file rather than to save it.
g) Your selected database references have now been exported into your EndNote Desktop library.
	a) Navigation from Library homepage to Find Resources > Databases > Popular > EBSCOhost Web
b) Click EBSCOhost Web. Tick Business Source Complete to select it and press Continue.
c) Do a search on your topic.
d) Select the references you want to export by clicking the Folder [image: ] next to each result.
e) Click on [image: ] icon (top of screen).
f) Select all articles -- tick Select / deselect all. Click [image: ] icon (right of screen).
g) Keep Direct Export in RIS Format selected, press Save button.
h) If the Save As box appears to save the .ris file, save it to the desktop, then open it. Alternatively, you may have the option to open the .ris file rather than to save it.
i) Your selected database references have now been exported into your EndNote Desktop library.



Each time you export references from a search tool (e.g. library database, LibrarySearch, Google Scholar), the newly imported references will appear in the Recently Added folder within your EndNote Desktop library. The references will also appear in the All References (master) folder. Each time you import new references, they will replace the previous references within Recently Added. All references will still permanently stay within All References unless you manually delete them.

When you open the .ris file, if you are asked what program to open it with, select EndNote (you may need to browse the list of programs) and tick the option to always use this program to open these files.

NOTE: Always check each exported reference to ensure that no information is incorrect or missing. Also, many databases have this exporting function, however, they all use different names for it, e.g. Send to; Export citation(s); Export; Export/Save; Save; Save to; EndNote [button].
4. EXPORTING REFERENCES FROM LIBRARY SEARCH - EXERCISE TWO

Exporting from LibrarySearch is best for references not usually found in library databases such as books, DVDs, etc.

To export references from LibrarySearch into your EndNote Desktop library:

1) Ensure your EndNote Desktop library is open.

2) Do a search on a topic. For example, “polymer composites”.
3) Mark the records you want to export from LibrarySearch by pressing the Pin[image: ] on the right of each record.

Note: To export a single or individual LibrarySearch reference, skip step 3 and instead select the EndNote [image: ] icon to the right of the reference’s title. Then go to step 7.
4) Go to My Favourites by pressing the Pin[image: ]on the top right corner of the screen.
5) Tick the records [image: ]you want to import into your EndNote Desktop library.

6) Click the Ellipses … icon to the right of the My Favourites just below the search box.
[image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\LS_export.PNG]

7) Click Export Record  [image: ].
8) Click the Encoding drop-down list. Select the UTF-8 option. Press Download [image: ].

9) If the Save As box appears to save the .ris file, save it to the desktop, then open it. Alternatively, you may have the option to open the .ris file rather than to save it. Your EndNote Desktop library must be open for this step.

10) Your LibrarySearch references have now been exported into your EndNote Desktop library.

NOTE: Always check each exported reference to ensure that no information is incorrect or missing.

When you open the .ris file, if you are asked what program to open it with, select EndNote (you may need to browse the list of programs) and tick the option to always use this program to open these files.

5. EXPORTING REFERENCES FROM GOOGLE SCHOLAR - EXERCISE THREE

Google Scholar is best for searching academic or scholarly material on the internet. References from Google Scholar searches can be exported into an Endnote Desktop library.

To export references from Google Scholar into your EndNote Desktop library:

1) Ensure your EndNote Desktop library is open.

2) Navigate to Google Scholar from the Library homepage (Find Resources > Other Sources > Search Google Scholar). If prompted, log in with your RMIT student / staff number and password. Logging on in this step will authenticate you as an RMIT student / staff member, so you can access the full-text of our online resources.

3) At the top right corner, click on Sign in  [image: ] and log in with your RMIT student / staff e-mail and password. You're now signed into your Google Scholar account -- you can Sign Out when finished. Logging on in this step will enable you to export multiple references simultaneously into your EndNote Desktop library.

Note: If you have entered your RMIT e-mail address, clicked on Next and nothing happens, or if you receive the following message at this step -- 'Something went wrong, Sorry, something went wrong there' -- go directly to Google Scholar (https://scholar.google.com.au/) and log in via the above Sign in button again using the same RMIT e-mail address.

4) Do a search on a topic. For example, “polymer composites”.

5) Click on the white star [image: ]  to select the references you want to export into your EndNote Desktop library. This will save the reference to My Library.

[image: \\ntapprdfs01n01.rmit.internal\el5\E89135\Configuration\Desktop\endnote libguide screenshots\google scholar\save_citation_star.png]

6) When a reference has been saved to My Library, the white star changes colour to blue[image: ] . Clicking on the blue star removes the reference from My Library.








7) Click on My Library on top right corner.

[image: \\ntapprdfs01n01.rmit.internal\el5\E89135\Configuration\Desktop\endnote libguide screenshots\google scholar\my_Library_icon2.png]

In here, you'll see a list of all the references you have saved in step 5. Tick the references you want to export into your EndNote Desktop library.

[image: \\ntapprdfs01n01.rmit.internal\el5\E89135\Configuration\Desktop\endnote libguide screenshots\google scholar\tick_citations.png]
8) Press Export [image: ] and select EndNote. If the Save As box appears to save the .enw file, save it to the desktop, then open it. Alternatively, you may have the option to open the .enw file rather than to save it. Your EndNote Desktop library must be open for this step.

[image: \\ntapprdfs01n01.rmit.internal\el5\E89135\Configuration\Desktop\endnote libguide screenshots\google scholar\download_selected.png]

9) Your Google Scholar references have now been exported into your EndNote Desktop library.

NOTE: Always check each exported reference to ensure that no information is incorrect or missing.

When you open the .enw file, if you are asked what program to open it with, select EndNote (you may need to browse the list of programs) and tick the option to always use this program to open these files.
6. MANUAL INPUT OF REFERENCES - EXERCISE FOUR

[bookmark: _Hlk7169487]References can be manually entered into an EndNote Desktop library. Manual entry is needed when the resource you are using is not in LibrarySearch, library databases or Google Scholar, and thus does not have the option to be exported into EndNote Desktop. An example of a reference requiring manual entry would be a report from a government department’s website, or information your find on other websites.

To manually enter references into your EndNote Desktop library:
1) Create a new reference (References > New Reference or click [image: ] on the toolbar).
The default setting for new references is Journal Article [image: ].
If you are using something else, you can change the reference type within the Reference Type drop-down list, e.g. Book, Book Section [for book chapters in edited books], Conference Paper, Web Page.

2) Fill in the content for the fields you need. To practice doing this, you can manually enter the sample references from the next page. Then, File > Save. Click the small grey cross [image: ] to close the reference. 

3) Here are the Reference, Preview and Attached PDFs tabs on the screen:

[image: ] 

	Select your reference, then:

· Make quick corrections to the reference in the Reference tab.
· See what your reference looks like in your chosen referencing style in the Preview tab.
· View the reference’s attached full-text PDF in the Attached PDFs tab.
· Manually attach the full-text PDF for your reference by clicking on the paperclip icon.

NOTES:

For manual entry of a reference, the Minimum Fields handout specifies the minimum type of fields that need to be completed for different types of references. Your referencing style may require more fields, so you will need to be familiar with its requirements. You can learn how to reference in your style using the Library’s resources on Referencing.       

	Tips:
· List author last name (family/surname) first and follow with a comma – e.g., Benton, Tim                 
· Organisation names should be entered in full and follow with a comma – e.g., “RMIT University,”
· Enter each author name on a separate line.
· Space between author initials.
· Full stop after each author initial – e.g., Smith, J. O.
· Sentence case for journal article titles.



List of references to practice manual entry (in RMIT Harvard style):

Book
Gartner, LP & Hiatt, JL 2015, Cell biology and histology, 7th edn, Wolters Kluwer Health, Philadelphia.
 
Journal article
Vladut-Severian, I 2013, 'Urban sustainability and integrated urban water management', Journal of Engineering Studies and Research, vol. 19, no. 4, pp. 25-33.
 
Web Page
Murray-Darling Basin Authority n.d., Salinity, Murray-Darling Basin Authority, viewed 5 December 2018, <https://www.mdba.gov.au/managing-water/salinity>.

Article from a Newspaper Website
Presiss, B 2012, ‘Academic calls for plagiarism rules overhaul’, Sydney Morning Herald, 20 August, viewed 19 January 2015, <http://www.smh.com.au/national/academic-calls-for-plagiarism-rules-overhaul-20120820-24imt.html>.

Blog
Eaton, S 2013, ‘What is the difference between a citation and a reference’, Literacy, Languages & Leadership, blog post, 18 October, viewed 19 January 2015, <https://drsaraheaton.wordpress.com/2013/10/18/whats-the-difference-between-a-citation-and-a-reference/>.

Government Report
Department of Education and Training 2014, Boosting the commercial returns from research, Australian Government, viewed 20 January 2015, <https://submissions.education.gov.au/Forms/higher-education-research/Documents/Boosting%20Commercial%20Returns%20from%20Research%20%20%2024102014.pdf>.









7. ADDING OR ATTACHING FULL-TEXT PDFs

Once you have populated your EndNote Desktop library by inserting references from library databases, LibrarySearch, Google Scholar or manual input, you can attach their full-text PDFs (the whole article or paper) to new references. You can do this only for online journal articles and conference papers, not e-books. Please refer to the step-by-step instructions: http://rmit.libguides.com/endnote/full-text. 

Alternatively, if you already have a folder of PDFs on your computer, you can import them into your Endnote Desktop library to have EndNote automatically create their references. Please see the Adding full-text PDF articles to create new references (PDF Import option) box within the above link.

8. GROUPS

Groups make it easy to break a large EndNote Desktop library into sub-categories. A group creates a ‘folder’ of references that already exist within your library. When you create a group and populate it with references, you are not moving them from All References; you are simply creating copies of them.

[image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\groups.png]There are two types of groups you can create:

1) Create a new Group

Right-click on My Groups > Create Group, or from the toolbar menu Groups > Create Group. Name your group whatever you like (e.g. a topic you are researching). Drag-and-drop some references from All References into your new group.

2) Create a new Smart Group

Right-click on My Groups > Create Smart Groups, or from the toolbar menu Groups > Create Smart Group. Name your group whatever you like (e.g. a topic you are researching). Press the Author drop-down list, scroll up and select Any Field. In the text box, type a word that commonly appears in your references (e.g. in title, author or abstract). Click Create. This creates a group that will automatically add existing and new future references if they have your chosen word in any field within the citation.
[image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\smart groups - handout.png]

9. SELECTING REFERENCING STYLES

In order for EndNote to correctly display your references in both your EndNote Desktop library and your Microsoft Word document, you will need to choose the referencing style you would like to use within your library and document. The style selected should be the same in both.

To select your referencing style in EndNote Desktop:

1) Click on the Style drop-down list and select your style.
2) If your style is not within the list, click Select Another Style. Then select the style you want from the Choose A Style pop-up box, e.g. Harvard_RMIT_EndNote, IEEE_RMIT_EndNote.
3) Click Choose to add it to the list for quick access.

[image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\style dropdown list - Word.png]  [image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\style popup box.png]

NOTE: Other styles not in the Style drop-down list can be downloaded via Edit > Output styles > Open Style Manager > Get More on the Web.

We will cover how to choose your referencing style in Microsoft Word in section 10. 













10. USING ENDNOTE DESKTOP WITH MICROSOFT WORD - EXERCISE FIVE

NOTE: In order for Microsoft Word, EndNote Desktop and the Windows operating system to work properly with each other, specific compatibility and system requirements need to be met.

1) Open your own Microsoft Word document to practice or, alternatively, you can download and open the Library’s sample Word document.

2) ENDNOTE X9 TAB

Once your document is open, click the EndNote X9 tab. Select the same referencing style from the Style drop-down list that you have selected in EndNote Desktop. If your required referencing style is not in the list, search for a different style by clicking on Select Another Style within the drop-down list.
[image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\Word_X9tab.PNG]

3) INSERTING REFERENCES: TWO METHODS

You can now insert references from your EndNote Desktop library into your Word document.

Method A

a) In Word: put your cursor where you would like to insert the citation, then add a space.
b) In EndNote: highlight the reference(s) you want to insert and select Insert Citation [image: ].
c) The in-text reference(s) has been inserted into your Word document. A reference list or bibliography will also be automatically created at the end of the document containing the full details of that in-text reference(s).

Method B
a) In Word: click Insert Citation [image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\insert_citation.PNG] and enter a keyword that appears within your EndNote Desktop library references (e.g. author last name, title, abstract).
b) Click Find and a list of matching search results will appear. Then select the reference(s) you want to insert and click Insert.
c) The in-text reference(s) has been inserted into your Word document. A reference list or bibliography will also be automatically created at the end of the document containing the full details of that in-text reference(s).

Regardless which method you use, both the in-text references and bibliography become grey when you click on them because they are linked to your EndNote Desktop library (i.e. EndNote-linked references).
4) EDITING REFERENCES

You can edit the EndNote-linked references you have inserted into your Word document. When you edit your grey EndNote-linked references in Word, do NOT directly type over the text with your keyboard. This can damage your Word document and the EndNote-linked references within. Please follow these instructions:

Add a page number

When you want to quote an author’s idea rather than paraphrase it, you need to insert the page number the quote appears on within the in-text citation.

a) Place your mouse cursor on the in-text citation you want to add a page number to.
b) Click on Edit & Manage Citation(s) [image: ]. Ensure that the correct reference (citation) is selected.
c) In the Pages field, enter only the page number, e.g. 41. Click OK. 
d) The page number now appears within your in-text citation. Page numbers will only appear if your referencing style allows it (e.g. APA 6th, RMIT Harvard).

Hide author name and display only the year

You may sometimes want to integrate the author’s name within the main text of your document rather than put it in brackets at the end of the sentence. For example: According to Bertran (2018), it was recently discovered that… In this case, you need to hide the author’s name and display only the year (and page number, if applicable) within the in-text citation.

a) Place your mouse cursor on the in-text citation of which you want to hide the author name.
b) Click on Edit & Manage Citation(s) [image: ]. Ensure that the correct reference (citation) is selected.
c) Click the Formatting drop-down list within the Edit Citation tab, then select Exclude Author. Click OK.
[image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\formatting dropdown list.png]

d) The author name is now hidden within your in-text citation, and only the year shows. To show the author name once again, select Default instead of Exclude Author. 
Fix a misspelling

If there is a misspelling within an in-text citation or bibliography reference in your Word document:

a) Place your mouse cursor on the citation which has the misspelling.
b) Click on Edit & Manage Citation(s) [image: ]. Ensure that the correct reference (citation) is selected.
c) Go to your EndNote Desktop library. Open the reference which contains the spelling error. Correct the spelling and save the reference.
d) Go back to your Word document. Click Update Citations and Bibliography [image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\edit and manage citations.PNG] to update the changes within your document.
e) Your Word document now contains the correct spelling.

5) REMOVING REFERENCES

You can remove the EndNote-linked references you have inserted into your Word document. When you remove your grey EndNote-linked references in Word, do NOT directly remove them with the Backspace or Delete button on the keyboard. This can damage your Word document and the EndNote-linked references within. Please follow these instructions:

a) Place your mouse cursor on the citation you want to delete.
b) Click on Edit & Manage Citation(s) [image: ]. Ensure that the correct reference (citation) is selected.
c) Click the arrow of the Edit Reference button [image: \\ntapprdfs01n01.rmit.internal\el5\E89135\Configuration\Desktop\Capture.PNG] to the right of the reference. Then select Remove Citation. Click OK.
d) Click Update Citations and Bibliography [image: \\rmit.internal\USRHome\el5\E89135\Configuration\Desktop\edit and manage citations.PNG] to update the changes within your document.
e) [bookmark: _GoBack]That instance of your in-text citation has been removed from your Word document. If that was its last instance, its corresponding bibliography reference has also been removed from your document.
                        
Removing an in-text citation or bibliography reference in your Word document does not remove the same reference from your EndNote Desktop library.

If you want to delete a reference from your EndNote Desktop library, first ensure that it has not been previously inserted into your Word document. If it has and you still delete it, your Word document will become corrupt and problematic. To avoid this, first remove the reference from your Word document, then delete it from your EndNote Desktop library.




11. BACKING UP YOUR ENDNOTE DESKTOP LIBRARY

It is important to regularly save and backup your EndNote Desktop Library to ensure you do not lose your work. You do this by creating a compressed EndNote Desktop Library. Please refer to the step-by-step instructions: http://rmit.libguides.com/endnote/backup.

12. FINAL TIPS

· EndNote basic
https://www.rmit.edu.au/library/research/endnote-managing-your-references/endnote-basic

EndNote basic is the web-based, free and simplified version of the EndNote Desktop program. EndNote basic allows you to sync your EndNote Desktop library with your EndNote basic library, so you can use it ‘in the cloud’, anytime and anywhere with internet access. You can also use EndNote basic on its own as an alternative to using EndNote Desktop. Although EndNote basic does not contain some of the features of the Desktop version, it is useful for undergraduates, Vocational Education students and anyone who needs to use a small number of references.To use EndNote basic, you will first need to create an account: www.myendnoteweb.com/.

More information:
http://rmit.libguides.com/EndNote_Online
http://endnote.com/product-details/basic

· EndNote: a Beginner’s Guide
http://rmit.libguides.com/endnote

You can use this guide as a self-paced learning tool to go through what was outlined in this handout to reinforce your understanding, or to explore other EndNote Desktop features not comprehensively covered in this handout (e.g. adding full-text PDFs, creating a backup, EndNote basic, Journal Term Lists, using Filters).

· EndNote: Managing your References
https://www.rmit.edu.au/library/research/endnote-managing-your-references

This is RMIT Library’s official EndNote website. Access self-paced learning materials, download EndNote Desktop to your own device, learn about EndNote basic, and explore alternatives to EndNote.







13. CONCLUSION AND FURTHER HELP 

· RMIT University Library cannot fix complex technical problems with your Endnote Desktop or EndNote basic libraries and documents. If you require advanced technical troubleshooting, please refer to EndNote.com.

· If you have technical issues with downloading or installing EndNote Desktop, please refer to the RMIT’s IT Service and Support Centre: https://www.rmit.edu.au/students/support-and-facilities/it-services-for-students/service-and-support-centre.

· Students and staff can ask for EndNote Desktop or EndNote basic assistance in person at any RMIT University Library service desk, or via Ask the Library service: https://www.rmit.edu.au/library/help/ask-the-library.

· The Help and Training page on the EndNote: a Beginner’s Guide lists various resources you can consult for further assistance: http://rmit.libguides.com/endnote/help.

· As EndNote is not a substitute for knowing how to reference, you should become familiar with the referencing style your School, supervisor or lecturer wants you to use. Learn how to reference using the resources below:

· Easy Cite referencing tool
· Referencing guides for printing
· Learning Lab: Referencing

Prepared by RMIT University Library
www.rmit.edu.au/library/endnote
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